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1 Introduction 
This document describes the format of the XML-data exported from Biacore T200 Software version 3.2.1 and 

newer. The exported data can be generated manually from the File: Export menu or automatically when a 

result file is saved (only in GxP-mode). 

The XML files are generated using “iso8859-1” encoding. 

All numerical values are exported with full precision and with dot (.) as decimal separator. 

All date-time values are exported in the format “YYYY-MM-DD HH:MM:SS”. For some values the time part is 

omitted. 

All tables are exported as an XML structure that defines the row and column headers. The table itself is 

exported as a CDATA section containing tab-separated text with each table row on a separate line. 

Description The generic table format used in the export. 

Format 
 

<Table Name="$(Table name)"> 

  <Column$(Column index)>$(Column name)</Column$(Column index)> 

  <Row$(Row index)>$(Row name)</Row$(Row index)> 

  <Data><![CDATA[$(Table data)]]> 

  </Data> 

</Table> 

where  

$(Table name) – the name of the table.  

$(Column index) – an index value indicating the number of the data column. First index is 
1. All column# nodes should be read until the sought node doesn’t exist. 

$(Column name) – the name of the column.  

$(Row index) – an index value indicating the number of the data row. First index is 1. All 
row# nodes should be read until the sought node doesn’t exist. 
Note: Is omitted in tables that have no specific name of the rows. 

$(Row name) – the name of the row. Note: Is omitted in tables that have no specific name of 
the rows. 

$(Table data) – is the list of table data values. Each table row is on a separate line with 
the column values as tab separated data. 

Example 
 

<Table Name="Report"> 

  <Column1>ka (1/Ms)</Column1> 

  <Column2>kd (1/s)</Column2> 

  <Column3>KD (M)</Column3> 

  <Row1>Cycle: 7  2 nM</Row1> 

  <Row2>Cycle: 9  8 nM</Row2> 

  <Row3>Cycle: 11  32 nM</Row3> 

  <Data><![CDATA[79294.04 0.000114 1.4404175E-09 

    78843.23 0.000192 1.417225E-09 

    80634.28 0.000125 1.450221E-09 

]]></Data> 

</Table> 
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2 Biacore T200 Control Software 

Description The root node that contains all other data carrying nodes. 

Format 
 

<LIMSInformation> 

  <FileInformation> … </FileInformation> 

  <AuditTrail> … </AuditTrail> 

  <Table> … </Table> 

</LIMSInformation> 

where 

<LIMSInformation> – is the root node. 

<FileInformation> – is the node where the file information is stored, 
see detailed format of node in chapter 2.1. 

<AuditTrail> – is the node where the audit trail information is stored, 
see detailed format of node in chapter 2.2.  
Note! This node is only present in published mode when the GxP 
module is installed. 

<Table> – is the node where the exported report point table is stored, 
see detailed format of node in chapter 2.3. 

 

2.1 /LIMSInformation/FileInformation 

Description This node contains the file information data. The data exported into 
this node is equivalent to the data displayed in the File Properties 
dialog box in the Biacore T200 Control Software. 

Format <FileInformation> 

  <FileProperties> … </FileProperties> 

  <RunInformation> … </RunInformation> 

  <Instrument> … </Instrument> 

  <UserInformation> … </UserInformation> 

  <CreatedWithSoftware> … </CreatedWithSoftware> 

  <CurrentSoftware> … </CurrentSoftware> 

  <ChipInformation> … </ChipInformation> 

  <Immobilization> … </Immobilization> 

</FileInformation> 

where 

The sub nodes listed here are described in the chapters below. 
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2.1.1 /LIMSInformation/FileInformation/FileProperties 

Description This node contains BLR-file related properties. 

Format <FileProperties> 

  <Name>$(File name)</Name> 

  <Path>$(Path)</Path> 

  <Size>$(File size)</Size> 

</FileProperties> 

where 

$(File name) – is the name of the file including file extension. 

$(Path) – is the path where the result file is stored. 

$(File size) – is the size of the file in bytes including the text “bytes” 

Example <FileProperties> 

  <Name>Dummy.blr</Name> 

  <Path>C:\Bia Users\GxP Results</Path> 

  <Size>100 000 bytes</Size> 

</FileProperties> 
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2.1.2 /LIMSInformation/FileInformation/RunInformation 

Description This node contains information regarding the run. 

Format <RunInformation> 

 <Type>$(Run type)</Type> 

 <Method>$(Method)</Method> 

 <Template>$(Template)</Template> 

 <PublishedProcedure>$(Procedure)</PublishedProcedure> 

  <PublishedProcedureVersion>$(Procedure version) 

</PublishedProcedureVersion> 

 <PublishedProcedureFile>$(Procedure file) 

</PublishedProcedureFile> 

 <Cycles>$(Cycle count)</Cycles> 

 <Start>$(Start date)</Start> 

 

<Reasonforunexpectedendofrun>$(UnexpectedRunEndReason)</Reasonforu

nexpectedendofrun> 

 

 <End>$(End date)</End> 

</RunInformation> 

where 

$(Run type) – is a string that identifies the type of the run. It is the name of 
the wizard that created the run. 

$(Method) – the name of the method used to create this file.  
Note! Only available for runs created with a method. 

$(Template) – the name of the wizard template used to create this file.  
Note! Only available for runs created with a wizard template. 

$(Procedure) – is the name of the Published procedure that was used to 
create this run. Note: Only available for runs created with a published 
procedure. 

$(Procedure version) – is the number of the active version of the published 
procedure used to create this run.  
Note: Only available for runs created with a published procedure. 

$(Procedure file) – is the name (including full path) of the published 
procedure file that was used to create this run.  
Note: Only available for runs created with a published procedure. 

$(Cycle count) – is the number of cycles present in this file. 

$(Start date) – is the date (as an invariant string) when this run was started. 

$(End date) – is the date (as an invariant string) when this file was ended. 

$(UnexpectedRunEndReason) – if the run was stopped due to an unexpected 
event the reason is written here as text. This node is not present as default. 
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Example <RunInformation> 

 <Type>Immobilization</Type> 

 <PublishedProcedure>Dummy procedure</PublishedProcedure> 

 <PublishedProcedureVersion>1</PublishedProcedureVersion> 

 <PublishedProcedureFile>C:\BIA Users\Published Procedures\Dummy 

procedure.bpp</PublishedProcedureFile> 

 <Cycles>4</Cycles> 

 <Start>2006-02-01 09:28:09</Start> 

 <End>2006-02-01 11:28:38</End> 

</RunInformation> 

 

2.1.3 /LIMSInformation/FileInformation/Instrument 

Description This node contains information about the instrument that was used to 
create this run. 

Format <Instrument> 

  <InstrumentType>$(Instrument)</InstrumentType> 

  <InstrumentId>$(Instrument id)</InstrumentId> 

  <IFC>$(IFC)</IFC> 

  <VacuumUnit>$(Vaccum status)</ VacuumUnit> 

</Instrument> 

where 

$(Instrument) – is the instrument type that created this run. This 
value is always “BiacoreT200”. 

$(Instrument id) – is the serial number of the instrument that was 
used to create this run. 

$(IFC) – is the name of the IFC type that was inserted in the 
instrument. 

$(Vacuum status) – has the value ‘Yes’ if the used instrument had an 
active vacuum unit. 

Example <Instrument> 

  <InstrumentType>BiacoreT200</InstrumentType> 

  <InstrumentId>12001</InstrumentId> 

  <IFC>TYPE105</IFC> 

</Instrument> 
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2.1.4 /LIMSInformation/FileInformation/UserInformation 

Description This node contains information about the user that created the run 
and the user that exported the file. 

Format <UserInformation> 

  <RunPerformedBy>$(Run by user)</RunPerformedBy> 

  <CurrentUser>$(Current user)</CurrentUser> 

</UserInformation> 

where 

$(Run by user) – is the username of the user that was logged into 
Windows when the run was started. 

$(Current user) – is the name of the username that was logged into 
Windows when the exported file was created. 

Example <UserInformation> 

  <RunPerformedBy>user</RunPerformedBy> 

  <CurrentUser>user2</CurrentUser> 

</UserInformation> 

 

2.1.5 /LIMSInformation/FileInformation/CreatedWithSoftware 

Description This node contains information about the software that was used to 
create this file. 

Format <CreatedWithSoftware> 

  <Name>$(Software name)</Name> 

  <Version>$(Software version)</Version> 

  <Module>$(Software module)</Module> 

  <Update>$(Update)</Update> 

</CreatedWithSoftware> 

where 

$(Software name) – is the name of the software that was used to 
create the run. 

$(Software version) – is the version of the software that was used to 
create the run. 

$(Software module) – contains the name of optional modules 
installed. This node can occur more than once in this 
<CreatedWithSoftware> node.  
Note! If the GxP module is installed it appears as “GxP Module” in this 
node 

$(Update) – contains the name of optional installed software updates. 
This node can occur more than once in this <CreatedWithSoftware> 
node.  
Note! This type of update is usually not used in Biacore T200. 
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Example <CreatedWithSoftware> 

  <Name>Biacore T200 Control Software</Name> 

  <Version>1.1</Version> 

  <Module>GxP Module</Module> 

  <Update>New MS maldi plate 2006-01-01</Update> 

</CreatedWithSoftware> 

 

2.1.6 /LIMSInformation/FileInformation/CurrentSoftware 

Description This node contains information about the software that was used to 
create this exported meta data file. 

This can be a different software than the file was created with. 

Format <CurrentSoftware> 

  <Name>$(Software name)</Name> 

  <Version>$(Software version)</Version> 

  <Module>$(Software module)</Module> 

  <Update>$(Update)</Update> 

</CurrentSoftware> 

where 

$(Software name) – is the name of the software that was used to 
create this exported meta data file. 

$(Software version) – is the version of the software that was used to 
create this exported meta data file. 

$(Software module) – contains the name of optional modules 
installed. This node can occur more than once in this 
<CurrentSoftware> node.  
Note! If the GxP module is installed it appears as “GxP Module” in this 
node. 

$(Update) – contains the name of optional installed software updates. 
This node can occur more than once in this <CurrentSoftware> node.  
Note! This type of update is usually not used in Biacore T200. 

Example <CurrentSoftware> 

  <Name>Biacore T200 Control Software</Name> 

  <Version>1.1</Version> 

  <Module>GxP Module</Module> 

  <Update>New MS maldi plate 2006-01-01</Update> 

</CurrentSoftware> 
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2.1.7 /LIMSInformation/FileInformation/ChipInformation 

Description This node contains information about the currently inserted sensor 
chip. 

Format <ChipInformation> 

  <ChipId>$(Chip id)</ChipId> 

  <ChipLotNo>$(Chip lot no)</ChipLotNo> 

  <ChipName>$(Chip name)</ChipName> 

  <FirstDockDate>$(First dock date)</FirstDockDate> 

  <LastModificationDate>$(Mod. date)</LastModificationDate> 

  <LastUseDate>$(Last use date)</LastUseDate> 

</ChipInformation> 

where 

$(Chip id) – is the id of the chip as entered when the chip was 
docked. 

$(Chip lot no) – is the lot number of the chip as entered when the 
chip was docked. 

$(Chip name) – is the name of the docked chip type. 

$(First dock date) – is the date when the chip was docked for the 
first time. Date as invariant string. 

$(Mod. date) – is the date when the chip was modified the last time. A 
chip is modified via the immobilization wizard. Date as invariant string. 

$(Last use date) – is the date when the chip was used the last time. 
Date as invariant string. 

Example <ChipInformation> 

  <ChipId>The id of the chip</ChipId> 

  <ChipLotNo>1234567</ChipLotNo> 

  <ChipName>CM5</ChipName> 

  <FirstDockDate>2006-02-01</FirstDockDate> 

  <LastModificationDate>2006-02-03</LastModificationDate> 

  <LastUseDate>2006-02-05</LastUseDate> 

</ChipInformation> 
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2.1.8 /LIMSInformation/FileInformation/Immobilization 

Description This node contains immobilization information for the flow cells on the 
chip.  

This node occurs one time for each flow cells that exists in the IFC. For 
Biacore T200 this means that there will be 4 Immobilization nodes. 

Format <Immobilization> 

  <Flowcell>$(Flow cell)</Flowcell> 

  <ImmobilizationDate>$(Immob date)</ImmobilizationDate> 

  <ImmobilizationResultFile>$(Immob result file) 

</ImmobilizationResultFile> 

  <Ligand>$(Ligand)</Ligand> 

  <FinalResponse>$(Final response)</FinalResponse> 

</Immobilization> 

where 

$(Flow cell) – is the name of the flow cell that this node contains 
date for.. 

$(Immob date) – is the date when this flow cell was immobilized. The 
date as invariant string. This value can be empty if the flow cell isn’t 
immobilized. 

$(Immob result file) – is the name (including full path) of the result 
file that was created when this flow cell was immobilized. This value 
can be empty if the flow cell isn’t immobilized. 

$(Ligand) – is the name of the immobilized ligand. This value can be 
empty if the flow cell isn’t immobilized. If the flow cell is blank 
immoblized the value can be “[Blank]”. If the run was aborted during 
this cycle and it wasn’t possible to determine if the flow cell was 
successfully immobilized the value can be “[Incomplete results]”. 

$(Final response) – is the id of the chip as entered when the chip 
was docked. This value only contains data if the flow cell has been 
successfully immobilized. 

Example <Immobilization> 

  <Flowcell>Fc=1</Flowcell> 

  <ImmobilizationDate>2006-02-01</ImmobilizationDate> 

  <ImmobilizationResultFile>C:\BIA Users\GxP 

Results\Immob.blr</ImmobilizationResultFile> 

  <Ligand>Test ligand</Ligand> 

  <FinalResponse>1234.5</FinalResponse> 

</Immobilization> 
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2.2 /LIMSInformation/AuditTrail 

Description This node contains the audit trail information. 

Note: This node is only present if the GxP module is installed and the 
result file was generated using a published procedure. 

Format <AuditTrail> 

  <UnsavedChanges> … </UnsavedChanges> 

  <SavedChanges> … </SavedChanges> 

</AuditTrail> 

where  

<UnsavedChanges> – is the node where unsaved changes in the 
exported data are listed. If the file is exported after the file is saved this 
node will be empty. 

<SavedChanges> – is the node where the file previous versions of the 
data are listed. 

 

2.2.1 LIMSInformation/AuditTrail/UnsavedChanges 

Description This node contains the unsaved changes in the exported data. 

Format <UnsavedChanges> 

  <Change> … </Change> 

</UnsavedChanges> 

where  

<Change> – is the node where unsaved changes in the exported data 
are listed. 

 

2.2.1.1 /LIMSInformation/AuditTrail/UnsavedChanges/Change 

Description This node contains a change description and a comment. 

Format <Change Text="$(Change)" > 

  <Comment><![CDATA[$(Comment)]]></Comment> 

</Change> 

where  

<Comment> – is the node where the comment is located. 

$(Change) – is the text that describes the change. 

$(Comment) – is the user entered comment that explains the change. 

Example <Change Text="Edited Notebook"> 

  <Comment><![CDATA[The change description goes 

here.]]></Comment> 

</Change> 
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2.2.2 /LIMSInformation/AuditTrail/SavedChanges 

Description This node contains the listing of previous file versions. 

Format <SavedChanges> 

  <FileVersions> … </FileVersions> 

</SavedChanges> 

where  

<FileVersions> – is the node that contains the file version nodes.  

 

2.2.2.1 /LIMSInformation/AuditTrail/SavedChanges/FileVersions 

Description This node contains the listing of previous file versions. 

Format <FileVersions> 

  <File> … </File> 

</FileVersions> 

where  

<File> – is the node where a information about a file version is stored. 
The <File> node will occur once for each existing file version. 

 

2.2.2.1.1 /LIMSInformation/AuditTrail/SavedChanges/FileVersions/File 

Description This node contains detailed information about a file version. 

Format <File Version="$(Version)" Date="$(Date)" User="$(User)"> 

  <Change> … </Change> 

</File> 

where  

<Change> – is the node where each change in the file version are listed. 

$(Version) – is the node version number of the file version. First file 
version is 1. 

$(Date) – is the date when the file version was created. 

$(User) – is the name of the user that saved the file version. 

Example <File Version="1" Date="2006-02-01 11:28:39" User="usr"> 

  <Change> … </Change> 

</File> 
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2.2.2.1.1.1 /LIMSInformation/AuditTrail/SavedChanges/FileVersions/File/Change 

Description This node contains a change item for a saved filed version. 

Format <Change Text="$(Change text)"> 

  <Comment><![CDATA[$(Comment text)]]></Comment> 

</Change> 

where  

$(Change text) – is the attribute where the change is described in 
plain text. This text is auto generated by the system. 

$(Comment text) – is the user comment describing the change. This 
node may be empty. 

Example <Change Text=" Edited the report point 'Baseline' for all 

curves in cycle 1."> 

  <Comment><![CDATA[The comment text.]]></Comment> 

</Change> 

 

2.3 /LIMSInformation/Table 

Description This node contains the report point table data. 

This is all report points for all cycles and curves as a big tab separated 
table. 

Format Standard table format is used, see chapter 1. The name of the table is 
“ReportPointTable”. 

Column headers ending with the character # can be treated as 
numeric values.  

The table data contains one initial row with the column headers. The 
column header in the data table does not contain the # character. 

Note: Row names are not used. 
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Example <Table Name="ReportPointTable"> 

  <Column1>Cycle</Column1> 

  <Column2>Fc</Column2> 

  <Column3>Aprog</Column3> 

  <Column4>DiodeRow</Column4> 

  <Column5>Time</Column5> 

  <Column6>Window</Column6> 

  <Column7>AbsResp</Column7> 

  <Column8>SD</Column8> 

  <Column9>Slope</Column9> 

  <Column10>LRSD</Column10> 

  <Column11>Quality</Column11> 

  <Column12>Baseline</Column12> 

  <Column13>RelResp</Column13> 

  <Column14>Id</Column14> 

  <Column15>Chip</Column15> 

  <Column16>Ligand</Column16> 

  <Column17>Method</Column17> 

  <Column18>Procedure</Column18> 

  <Column19>TargetLevel#</Column19> 

  <Column20>ContactTime#</Column20> 

  <Column21>FlowRate#</Column21> 

  <Data><![CDATA[Cycle Fc Aprog DiodeRow Time

 Window AbsResp SD Slope LRSD Quality

 Baseline RelResp Id Chip Ligand Method

 Procedure TargetLevel ContactTime

 FlowRate 

1 1 Amine_1 10 273 5

 36808.0709635417 0.124936659977557

 0.0614955357142857 0.0544657669044648

 Ok Yes N/A Baseline CM5 Blank

 Amine Blank       

1 1 Amine_1 10 400 5

 43519.3209635417 1.46559342795652 -

0.783147321428571 0.041003831478355 Ok No 6711.25

 usr rpt CM5 Blank Amine Blank]]> 

  </Data> 

</Table>   
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3 Biacore T200 Evaluation Software 

3.1 /EvaluationFile 

Description The exported file from Biacore T200 Evaluation is an XML text file. The XML 
structure contains the audit trail (only in published mode with the GxP module 
installed), file properties and a section for each evaluation (item). 

Format <EvaluationFile> 

 <AuditTrail> 

  … 

 </AuditTrail> 

 <FileProperties> 

  … 

 </FileProperties> 

<Evaluation> 

… 

</Evaluation> 

<Evaluation> 

… 

</Evaluation> 

… 

</EvaluationFile> 

3.2 /EvaluationFile/AuditTrail 

The audit trail has the same export format as Biacore T200 Control Software (see chapter 2.2). 

3.3 /EvaluationFile/FileProperties 

Description The file properties section contains one section for the evaluation file 
properties and one section for all result files included in the evaluation file. The 
result files section contains a sub-section for each result file. 
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Format <FileProperties> 

 <EvalFileProperties> 

  … 

 </EvalFileProperties> 

 <ResultFiles> 

  <ResultFile1> 

   … 

  </ResultFile1> 

<ResultFile2> 

 … 

  </ResultFile2> 

  … 

 </ResultFiles> 

</FileProperties> 
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3.3.1 /EvaluationFile/FileProperties/EvalFileProperties 

Description The evaluation file properties section contains the properties of the evaluation 
file. The Notebook is saved as CDATA. 

Format <EvalFileProperties> 

 <EvaluationFile> 

… 

</EvaluationFile> 

<UserInformation> 

… 

</UserInformation> 

<CreatedWithSoftware> 

… 

</CreatedWithSoftware> 

<Notebook> 

<![CDATA[ … ]]>  

</Notebook> 

</EvalFileProperties> 

3.3.1.1 EvaluationFile/FileProperties/EvalFileProperties/EvaluationFile/ 

Description The name, path and size of the evaluation file. 

Format <EvaluationFile> 

<Name>$(Name)</Name>  

<Path>$(Path)</Path>  

<Size>$(Size)</Size>  

</EvaluationFile> 

where 

$(Name) – is the name of the evaluation file. 

$(Path) – is the path to the evaluation file. 

$(Size) – is the size (in bytes) of the evaluation file. 

Note: This section is empty if the file has not yet been saved as an evaluation 
file. 

Example <EvaluationFile> 

<Name>Kinetics.bme</Name>  

<Path>C:\Bia Users</Path>  

<Size>911356</Size>  

</EvaluationFile> 
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3.3.1.2 EvaluationFile/FileProperties/EvalFileProperties/UserInformation/ 

Description The username of the user that saved the file and the currently logged in user. 

Format <UserInformation> 

<PerformedBy>$(Performed by)</PerformedBy>  

<CurrentUser>$(Current user)</CurrentUser>  

</UserInformation> 

where 

$(Performed by) – is the user that last saved the evaluation file. 

$(Current user) – is the currently logged in user. 

Example <UserInformation> 

<PerformedBy>Wolfgang</PerformedBy>  

<CurrentUser>Helga</CurrentUser>  

</UserInformation> 

3.3.1.3 EvaluationFile/FileProperties/EvalFileProperties/CreatedWithSoftware/ 

Description Information about the software that created the file. 

Format <CreatedWithSoftware> 

<Name>$(Name)</Name>  

<Version>$(Version)</Version>  

<Modules> 

<Module>$(Module)</Module> 

<Module>…</Module> 

… 

</Modules> 

</CreatedWithSoftware> 

where 

$(Name) – is the name of the software that created the file. 

$(Version) – is the version of the software that created the file. 

$(Module) – is an installed software module, e.g. “GxP Module”. 

Example <CreatedWithSoftware> 

<Name>Biacore T200 Evaluation Software</Name>  

<Version>1.1</Version>  

<Modules> 

<Module>GxP Module</Module> 

</Modules> 

</CreatedWithSoftware> 
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3.3.2 EvaluationFile/FileProperties/ResultFilex 

Description The result file properties are child sections in the ResultFiles sections. The first 
result file is in the section ResultFile1, the second is in the ResultFile2 section 
and so on. 

The Immobilization sections contain immobilization information for the four 
flow cells. 

Format <ResultFile1> 

<ResultFile> 

… 

</ResultFile> 

<RunInformation> 

… 

</RunInformation> 

<Instrument> 

… 

</Instrument> 

<UserInformation> 

… 

</UserInformation> 

<CreatedWithSoftware> 

… 

</CreatedWithSoftware> 

<ChipInformation> 

… 

</ChipInformation> 

<Immobilization> 

… 

</Immobilization> 

<Immobilization> 

… 

</Immobilization> 

… 

</ResultFile1> 

3.3.2.1 EvaluationFile/FileProperties/ResultFilex/ResultFile/ 

Description The result file properties. 

Format This section has the same format as the corresponding section in the Biacore 
T200 Evaluation file properties (see chapter 3.3.1.3). 

 

  



 Biacore T200 Software 
 XML export format description 
 

Document number Document revision / Release date Page number 

28981396 AB / February 2021 20 of 31 

 

 

3.3.2.2 EvaluationFile/FileProperties/ResultFilex/RunInformation/ 

Description The information about the run. 

Format This section has the same format as the corresponding section in the Biacore 
T200 Control Software export format (see chapter 2.1.2). 

3.3.2.3 EvaluationFile/FileProperties/ResultFilex/Instrument/ 

Description The information about the instrument. 

Format This section has the same format as the corresponding section in the Biacore 
T200 Control Software export format (see chapter 2.1.3). 

3.3.2.4 EvaluationFile/FileProperties/ResultFilex/UserInformation/ 

Description This section contains information about the user that created the run. 

Format This section has the same format as the corresponding section in the Biacore 
T200 Control Software export format (see chapter 2.1.5), except that the 
CurrentUser section is not present. 

3.3.2.5 EvaluationFile/FileProperties/ResultFilex/CreatedWithSoftware/ 

Description This section contains information about the Control Software that created the 
run. 

Format This section has the same format as the corresponding section in the Biacore 
T200 Control Software export format (see chapter 2.1.5). 

3.3.2.6 EvaluationFile/FileProperties/ResultFilex/ChipInformation/ 

Description This section contains information about the chip that was used in the run. 

Format This section has the same format as the corresponding section in the Biacore 
T200 Control Software export format (see chapter 2.1.7). 

3.3.2.7 EvaluationFile/FileProperties/ResultFilex/Immobilization / 

Description This section contains information about the immobilization in one flow cell on 
the chip. 

Format This section has the same format as the corresponding section in the Biacore 
T200 Control Software export format (see chapter 2.1.8). 
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3.4 /EvaluationFile/Evaluation 

Description Each evaluation is exported as its own section. The Type section contains the 
type of evaluation, e.g. “Plot”, and the Name section contains the name of the 
evaluation, e.g. “Binding level”. The rest of the section is different for the 
different evaluations. 

Format <Evaluation> 

<Type>…</Type> 

<Name>…</Name> 

… 

</Evaluation> 

3.4.1 Sensorgram 

Sensorgram is not exported. 

3.4.2 Plot 

Description The Plot evaluation item. 
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Format <Evaluation> 

<Type>Plot</Type> 

<Name>$(Name)</Name> 

<XAxis> 

<Variable>$(Variable)</Variable> 

or 

<ReportPoint>$(ReportPoint)</ReportPoint> 

<ResponseType>$(ResponseType)<ResponseType> 

</XAxis> 

<YAxis> 

<ReportPoint>$(ReportPoint)</ReportPoint> 

<ResponseType>$(ResponseType)<ResponseType> 

</YAxis> 

<Ranking> 

  <RankingBoundary1>$(Ranking level 1)</RankingBoundary1> 

  <RankingBoundary2>$(Ranking level 2)</RankingBoundary2> 

  <RankedAsHigh>’Cycle’$(Cycles)</RankedAsHigh> 

  <RankedAsMedium>’Cycle’$(Cycles)</RankedAsMedium> 

  <RankedAsLow>’Cycle’$(Cycles)</RankedAsLow> 

</Ranking> 

<AdjustmentForControls> 

   <PositiveControl>$(Positive control)</PositiveControl> 

   <NegativeControl>$(Negative control)</NegativeControl> 

   <FittingFunction>$(Fitting function)</FittingFunction> 

</AdjustmentForControls> 

<curveFitting> 

      <curve> 

        <name>$(Curve name)</name> 

        <function>$(Fitting function)</function> 

        <Rhi>$(Rhi)</Rhi> 

        <Rlo>$(Rlo)</Rlo> 

        <A1>$(A1)</A1> 

        <A2>$(A2)</A2> 

        <Chi2>$(Chi2)</Chi2> 

      </curve> 

      <curve> ..... 

      </curve> 

         or 

      <curve> 

        <name>$(Curve name)</</name> 

        <function>$(Fitting function)</function> 

        <slope>$(Slope)</slope> 

        <intercept>$(Intercept)</intercept> 
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        <R2>$(R2)</R2> 

      </curve>    

      <curve> ..... 

      </curve> 

</curveFitting> 

 

<Table Name=”Table”> 

$(Table) 

<Table> 

</Evaluation> 

where 

$(Name) - is the name of the plot. 

$(Variable) - is the variable name. 

$(ReportPoint) - is the report point name. 

$(ResponseType) - is the response type. Possible values are "Absolute response", 
"Relative response", "Slope" and "MW adjusted response". 

$(Ranking level#) - is the ranking boundary level. The number of ranking levels is 
maximized to two. 

$(Cycles) - is a list of cycle numbers 

$(Positive/Negative -control) - is the name of selected control sample. 

$(Fitting function) - is the name of selected fitting function. 

$(Curve name) - is the name of the curve for current curve section. 

$(Rhi) – is the calculated Rhi value 

$(Rlo) – is the calculated Rlo value. 

$(A1) – is the calculated A1 value. 

$(A2) – is the calculated A2 value. 

$(Chi2) – is the calculated Chi2 value. 

$(Slope) – is the calulated slope value. 

$(Intercept) – is the calculated intercept value. 

$(R2) – is the calculated R2 value. 

$(Table) – contains the plot table in standard table format, see chapter 1.  

 
Note: The Ranking section is available only if ranking is performed. 

The AdjustmentForControls section is only available if adjustment for controls is 
performed. 

The curveFitting section is available only if curve fitting is performed. One curve 
section is available for each curve. Reported parameters are dependent of selected 
fitting function. 

The XAxis section contents are different if the plot is a “Report point vs variable” 
compared to a “Report point vs report point”. 
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3.4.3 Bar chart 

Description The Bar chart evaluation item. 

Format <Evaluation> 

<Type>Bar Chart</Type> 

<Name>$(Name)</Name> 

<Response Type>$(ResponseType)</ResponseType> 

<GroupBy>$(GroupBy)</GroupBy> 

<Table Name=”Table”> 

$(Table) 

<Table> 

</Evaluation> 

where 

$(Name) – is the name of the Bar chart. 

$(ResponseType) – is the response type. Possible values are "Absolute response" and 
"Relative response". 

$(GroupBy) – is the variable used to group the x-axis with. Possible values are "Cycle", 
"File", "FileAndCycle", "ReportPoint", "SampleName" and "Curve".  

$(Table) – contains the plot table in standard table format, see chapter 1. 

3.4.4 Report point table 

Description The Report point table evaluation item. 

Format <Evaluation> 

 <Type>Report Point Table</Type> 

 <Name>Report Point Table</Name> 

 <Table Name=”ReportTable”> 

 $(Table) 

</Table> 

</Evaluation> 

where 

$(Table) – contains the report point table in standard table format, see 
chapter 1. 

 

3.4.5 Solvent correction 

Solvent correction is not exported. 

 

3.4.6 Concentration analysis (Using calibration) 

Description The Concentration analysis evaluation item. 
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Format <Evaluation> 

<Type>Concentration Analysis</Type> 

<Name>$(Name)</Name> 

<CalibrationCurves> 

  <flowCell>$(Flow cell)</flowCell>  

  <reportPoint>$(Report point)</reportPoint>  

  <responseType>$(Response type)</responseType>  

  <calibrationMode>$(calibration mode)</calibrationMode> 

  <fittingFunction>$(Fitting function)</fittingFunction>    

   (If fitting function is Four parameter) 

   <CalibrationCurve> 

      <name>$(Calibration curve name)</name> 

      <sample>$(Sample)</sample> 

      <Rhi>$(Rhi)</Rhi> 

      <Rlo>$(Rlo)</Rlo> 

           <A1>$(A1)</A1> 

           <A2>$(A2)</A2> 

      <Chi2>$(Chi2)</Chi2> 

   </CalibrationCurve> 

<CalibrationCurve> 

..... 

</CalibrationCurve> 

   (If fitting function is Linear) 

<CalibrationCurve> 

<name>$(Calibration curve name)</name> 

<sample>$(Sample)</sample> 

<slope>$(Slope)</slope > 

             <intercept>$( intercept)</ intercept > 

<R2>$(R2)</R2> 

</CalibrationCurve> 

<CalibrationCurve> 

..... 

</CalibrationCurve> 

 

</CalibrationCurves> 

<Table Name=”CalibrationTable”> 

$(Calibration table) 

</Table> 

<Table Name=”ControlSampleTable”> 

$(Control sample table) 

</Table> 

<Table Name=”SampleTable”> 

$(Sample table) 
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</Table> 

</Evaluation> 

 

 where 

$(Name) – is the name of the concentration analysis. 

$(Flow cell) – is the name of selected flow cell 

$(Report point) – is the name of selected report point 

$(Response type) – is the name of selected response type 

$(calibration mode) – is the name of selected calibration mode 

$(Fitting function) – is the name of used fitting function 

$(Calibration curve name) – is the name of the calibration curve. 

$(Sample) – is the sample name for the calibration curve. 

$(Rhi) – is the calculated Rhi value 

$(Rlo) – is the calculated Rlo value. 

$(A1) – is the calculated A1 value. 

$(A2) – is the calculated A2 value. 

$(Chi2) – is the calculated Chi2 value. 

$(Slope) – is the calulated slope value. 

$(Intercept) – is the calculated intercept value. 

$(R2) – is the calculated R2 value. 

$(Calibration table) – contains the calibration table in standard table 
format, see chapter 1. 

$(Control sample table) – contains the control sample table in standard 
table format, see chapter 1. 

$(Sample table) – contains the sample table in standard table format, see 
chapter 1. 

Note: Reported parameters in the ‘calibrationCurve’ section are dependent of 
selected fitting function. If a custom fitting function is used the parameters for 
that current function is exported. 
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3.4.7 Concentration analysis (Calibration-free) 

Description The Calibration-free concentration analysis evaluation item. 

Format <Evaluation> 

<Type>Concentration Analysis</Type> 

<Name>$(Name)</Name> 

    <Series> 

       <Table Name="Concentration result"> 

           $(Result table) 

      </Table> 

    </Series>  

</Evaluation> 

 

where 

$(Name) – is the name of the calibration-free concentration evaluation item. 

$(Result table) – contains the calibration table in standard table format, see 
chapter 1. 
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3.4.8 Kinetics / Affinity 

Description The Kinetics / Affinity evaluation item. 

Format <Evaluation> 

 <Type>Kinetics / Affinity</Type> 

 <Name>$(Name)</Name> 

 <LigandName>$(Ligand)</LigandName> 

 <SampleName>$(Sample)</SampleName> 

 <Temperature>$(Temperature)</Temperature> 

       <CurveName>$(CurveName)</CurveName> 

 <Fits> 

  <Fit> 

   <Model>$(Model)</Model> 

   <Description>$(Description)</Description> 

   <Table Name=”Report”> 

    $(Report table) 

   </Table> 

   <Table Name=”Parameters”> 

    $(Parameters table) 

   </Table> 

  </Fit> 

  <Fit> 

   … 

  </Fit> 

  … 

 </Fits> 

</Evaluation> 

where 

$(Name) – is the name of the Kinetics / Affinity evaluation. 

$(Ligand) – is the ligand name. 

$(Sample) – is the sample name. 

$(Temperature) – is the temperature. 

$(CurveName) – is the name of selected curve. 

$(Model) – is the model used in the fit. 

$(Description) – is the description of the fit. 

$(Report table) – is the report table of the fit using standard table format, 
see chapter 1. 

$(Parameters table) – is the parameters table of the fit using standard table 
format, see chapter 1. 
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3.4.9 Thermodynamics 

Description The Thermodynamics evaluation item. 

Format <Evaluation> 

    <Type>Thermodynamics</Type> 

    <Name>$(Name)</Name> 

    <LigandName>$(Ligand name)<LigandName> 

    <SampleName>$(Sample)</SampleName> 

    <Table Name=”ImportTable”> 

         $(Import table) 

    </Table> 

    <Table Name=”ResultTable”> 

        $(Result table) 

    </Table> 

</Evaluation> 

where 

$(Name) – is the name of the Thermodynamics evaluation. 

$(Ligand name) – is the ligand name. 

$(Sample) – is the sample name. 

$(Import table) – is the import table of the fit using standard table format, 
see chapter 1. 

$(Result table) – is the result table of the fit using standard table format, see 
chapter 1. 
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3.4.10 Affinity in solution 

Description The Affinity in solution evaluation item. 

Format <Evaluation> 

 <Type>Affinity in Solution</Type> 

 <Name>$(Name)</Name> 

 <CalibrationCurveName>$(Calibration)</CalibrationCurveName> 

 <Table Name=”CalibrationTable”> 

  $(Calibration table) 

 </Table> 

 <Sample>$(Sample)</Sample> 

 <ConstantConcentrationB>$(Const. 

B)</ConstantConcentrationB> 

 <Table Name=”SampleTable”> 

  $(Sample table) 

  </Table> 

 <KD>$(KD)</KD> 

 <SEKD>$(SE KD)</SEKD>  Or  <TVALUEKD>$(T-value 

KD)</TVALUEKD> 

 <Chi2>$(Chi2)</Chi2> 

</Evaluation> 

where 

$(Name) – is the name of the Affinity in solution evaluation. 

$(Calibration) – is the name of the selected calibration curve. 

$(Calibration table) – is the calibration table using standard format, see 
chapter 1. 

$(Sample) – is the selected sample name. 

$(Const. B) – is the constant concentration B. 

$(Sample table) – is the sample table using standard format, see chapter 1. 

$(KD) – is the calculated KD value. 

$(SE KD) is the standard error of the calculated KD value. 

$(T-value KD) – is T-value of the calculated KD value. 

$(Chi2) – is the Chi2 in the curve fit. 
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